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Preface

About the Documentation

Target Audiences
The NEO SuiteView Layout Manager User Guide describes in 
nontechnical language how software administrators, station engineers, 
and operators can install and operate the software. 
This user guide does not provide information about the Harris 
SuiteView Layout Manager. 
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 : 
Revision History

Obtaining User Manuals
The documentation for this product is included on the Installation CD 
and as an Adobe Acrobat PDF file. An PDF file of the user guide can 
also be downloaded from our website at www.broadcast.harris.com/
leitch. This user guide is not available in print format.

Table P-1. Revision History of Manual

Edition Date Comments
A June 2006 This manual contains information previously 

found in the NEO SuiteView Multi-Source 
Display Processor and NEO SuiteView 
Layout Manager Software Application 
Installation and Operation Manual, Edition 
C. It is also includes documentation on 
feature additions to the NEO SuiteView 
Layout Manager application. 
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 : 
Writing Conventions
This documentation adheres to the following writing conventions:

Table P-2. Conventions

Term or Convention Description
Bold Indicates dialog box, property sheet, field, 

button, check box, list box, combo box, menu, 
submenu, window, list, and selection names

Italics Indicates email addresses, names of books and 
publications, and first instances of new terms 
and specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such 
as ENTER, TAB, CTRL, ALT, DELETE

Code Indicates variables or command-line entries, 
such as a DOS entry or something you type into 
a field

> Indicates the direction of navigation through a 
hierarchy of menus and windows

hyperlink Indicates a jump to another location in the 
document or elsewhere

Internet address Indicates a jump to a Web site or URL

Indicates important information that helps to 
avoid and troubleshoot problems

[VersionNo.] Placeholder for a software version number

Note
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Chapter 1

Introduction

Overview
The NEO SuiteView Layout Manager™ software is designed to 
configure and operate you NEO SuiteView system. Using this software, 
you can configure your NEO SuiteView system settings, including 
configuring input audio and video alarms, calibrating display 
monitoring, and creating and editing display layouts.
Each NEO SuiteView system has ten layout presets that you can recall 
for display using NEO SuiteView Layout Manager. You can edit these 
preset layouts by modifying individual Picture-in-Picture (PiP) layout 
settings to create custom display layouts. You can then upload the 
custom layouts to your NEO SuiteView system or save them to a local 
or network PC drive.
NEO SuiteView preset layouts can be recalled using a local or remote 
control panel; however, you cannot make edit or create custom presets 
using control panels. 
Using a CCS software application (such as Navigator), you can launch 
NEO SuiteView Layout Manager and then use some of layout 
manager’s features. For more information about using NEO SuiteView 
Layout Manager with CCS applications, see your NEO SuiteView 
Hardware Operation and Installation Manual.
When installed on a local or network PC, NEO SuiteView Layout 
Manager communicates directly with your NEO SuiteView system via 
an RS-232 serial communications port or via TCP/IP. If your NEO 
SuiteView system is part of a network, TCP/IP communication allows 
you to manage a network of NEO SuiteView systems.
NEO SuiteView Layout Manager is supported with Online Help.
NEO SuiteView Layout Manager User Guide 1



 Chapter 1: Introduction
The following topics are found in this chapter:
• “NEO SuiteView Layout Manager Features” on page 3 
• “Installing NEO SuiteView Layout Manager” on page 4
• “Launching NEO SuiteView Layout Manager” on page 6
• “Connecting to NEO SuiteView Systems” on page 7 
• “The NEO SuiteView Layout Manager Work Space” on page 11
2 NEO SuiteView Layout Manager User Guide
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NEO SuiteView Layout Manager Features
Using NEO SuiteView Layout Manager, you can perform the 
following:
• Create new layout/file configurations
• Read and edit all preset layouts/files that are stored on any 

locally- or network-connected NEO SuiteView system
• Save edited layouts/files to the NEO SuiteView system and to local 

or network PC drive
• Define which input PiP channels are visible on the output display
• Define the following properties for each PiP:

• PiP position
• PiP size
• PiP cropping
• PiP border margins and color
• PiP labels (including position and color)

• Resize and position PiPs using a standard Windows drag-and-drop 
operation

• Resize and position PiPs with pixel accuracy using direct-entry 
Window coordinates

• Copy the properties of a PiP to any other PiP
• Overlap PiPs and assign priority
• Move and resize any group of PiPs
• User SVG graphics for PiP skins and backgrounds
• Configure on-screen alarms and bar meters for up to eight 

embedded audio, analog audio, and AES digital audio channels for 
each PiP

• Configure analog audio and AES digital audio monitor output
• Monitors all NEO SuiteView systems for audio and video alarm 

conditions
NEO SuiteView Layout Manager User Guide 3
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Installing NEO SuiteView Layout Manager
You can install NEO SuiteView Layout Manager on a PC running a 
Windows 2000 or Windows XP operating system. After NEO 
SuiteView Layout Manager is installed, it can be launched on any PC 
system that meets the recommend system requirements.
Review the following tips and recommendations before installing NEO 
SuiteView Layout Manager:
• Leitch recommends installing NEO SuiteView Layout Manager on 

a system that is configured with a Pentium III processor (or larger) 
that is running at 866 MHz or faster.

• For server installations, Leitch recommends creating a new 
installation on a fresh hard drive and applying the latest service 
pack for both the operating system and Internet Explorer 6.0. 
Internet Explorer is required on the server to display extended SVG 
graphics.

• If client and server applications are installed on one machine, you 
may need to increase the normal Windows memory requirement to 
at least 256 MB.

• The minimum installation required to test the server installation is 
one NEO SuiteView system connected to the server’s COM 1 port. 
If a NEO SuiteView Layout Manager client can control the 
NEO SuiteView system, then the installation is successful.

• Leitch recommends a minimum output resolution of 1024 x 768.
4 NEO SuiteView Layout Manager User Guide
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Installing the Software
Before installing NEO SuiteView Layout Manager, ensure that you 
have a correct serial port or TCP/IP Ethernet connection between your 
PC and the NEO SuiteView system. 

Note
The installed NEO 3901RES-E resource card must be version 
res3901-rel-2-9-b4 or later to enable the TCP/IP connection. For more 
information, see your NEO SuiteView Hardware Operation and 
Installation Manual.

The following default installation procedure applies to single PC client/
server installations using serial connections:
To install the NEO SuiteView Layout Manager software, complete 
these steps:
1. Close all other applications running on the PC and insert the NEO 

SuiteView Layout Manager installation CD into the PC CD-ROM 
drive.
The setup program automatically runs when the drive closes. 

2. Follow the on-screen instructions to install the software to your 
system’s hard drive.

Note
If the installation does not auto-run, find and double-click the 
SuiteViewInstall_*.exe file on the CD (where “*” is the version number).
NEO SuiteView Layout Manager User Guide 5
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Launching NEO SuiteView Layout Manager
You can run NEO SuiteView Layout Manager software from a client 
PC or from a CCS software application such as Navigator. See the 
sections below for more information.

Running Software from a Server PC
If you are running the software from a server PC, click Start from the 
Windows task bar, select Programs, and then navigate to the NEO 
SuiteView Layout Manager application. Alternatively, click the NEO 
SuiteView Layout Manager icon on the PC desktop to launch the 
application.The default operating mode upon startup is RS-232.
For installations using a TCP/IP connection, you need to configure the 
Modify Devices window within the NEO SuiteView Layout Manager 
software application. See “Connecting to NEO SuiteView Systems” on 
page 7 for more information

Running Software through a CCS Application
If you intend to launch NEO SuiteView Layout Manager from a CCS 
software application such as Navigator, you must first discover the 
NSV-OUT module, switch to Control mode, and then enable the 
specific NEO SuiteView specific interface. From the Layout page, you 
can click Launch to open NEO SuiteView Layout Manager 
application. 
See the appropriate CCS User Manual or Online Help for more 
information on setting actions and launching/starting non-CCS 
applications. See also your NEO SuiteView Hardware Installation and 
Operation Manual for more information.
6 NEO SuiteView Layout Manager User Guide
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Connecting to NEO SuiteView Systems
Before you can use NEO SuiteView Layout Manager to create new 
layouts, modify existing layouts and transfer layouts to your NEO 
SuiteView system, you must configure your system so that it 
communicates with the NEO SuiteView Layout Manager software. This 
involves providing a device name for your NEO SuiteView System, 
defining it’s connection type, and providing a valid TCP/IP address (for 
Ethernet connections). The following section describes the procedure.
You can use NEO SuiteView Layout Manager to set up NEO SuiteView 
systems and match the COM ports used in connecting systems to the 
server. 

Note
When using the NEO SuiteView Layout Manager, a NEO SuiteView system 
is referred to as a Device and not System.

1. Run the NEO SuiteView Manager software (see “Launching NEO 
SuiteView Layout Manager” on page 6).

2. Select File > Modify Devices.
When you acknowledge the device disconnect message, the 
Modify Devices dialog box opens.

Figure 1-1. Modify Devices Dialog Box 
NEO SuiteView Layout Manager User Guide 7
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3. To set up a new NEO SuiteView system, click Add, and then enter 
a device name for the system in the text box. 
The device name identifies the system in the NEO SuiteView 
Layout Manager application and is analogous to a computer 
network name.

4. Select a connection type from the Connection Type list.
5. If your connection type is RS232 or RS485, select or enter the 

COM port used to serially connect your NEO SuiteView system to 
the network.
RS485 connections also require you to enter the RS485 address in 
the corresponding box.

6. If your connection type is TCP/IP, you will need to enter the IP 
address of your device’s RES3901-E resource card in the TCPIP 
Host box. The TCP/IP host address and the PC IP address should 
be on the same PC subnet. 
You must also enter the TCP/IP port number in the TCPIP Port 
box. Port numbers are always “5000 + x”, where x is the slot 
number of the NSV-OUT module. (For example, type 5004 if the 
NSV-OUT module is installed in slot 4.)

Note
Your installed RES3901-E resource card must be version 
res3901-rel-2-9-b4 or later to enable the TCP/IP connection. See 
“Ensuring the Use of Compatible CCS Application Version” on page 6 
for more information.

7. If you want to use SVG (background) graphics with your layouts, 
you must enter the VGA port used to connect your PC to the 
NEO SuiteView system. 

8. Click OK.
9. To connect your NEO SuiteView system to the NEO SuiteView 

Layout Manager software, do one of the following:
• On the left side of the NEO SuiteView Layout Manager 

window, double-click the Device icon that represents your 
newly added NEO SuiteView system.

OR
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• Select File > Connect or click Connect on the toolbar. 
When the connection is successfully established, available 
NEO SuiteView preset layouts will appear in the Explorer-style 
Device and Preset pane (left), and The connection status at the 
bottom of the SuiteView Layout Manager dialog box will read OK.

10. To be sure that your NEO SuiteView System is connected and 
properly working, select different presets from Device and Preset 
pane.
If you receive a connection error message when NEO SuiteView 
Layout Manager attempts to connect to your NEO SuiteView 
system, see the next section.

Note
For TCP/IP connections, ensure that the IP address has been entered 
correctly in the Modify Devices dialog box (see “Connecting to 
NEO SuiteView Systems” on page 7), that the NEO SuiteView system 
is turned on, and that all cables are properly connected.

Resolving a Connection Error
If NEO SuiteView Layout Manager was unable to connect with your 
NEO SuiteView system, you will receive the following error message:

Attempt to resolve the connection error by checking that your serial or 
TCP/IP connection is correct. To do this following these instructions.

• For serial connections, ensure that RS-422 null modem cable is 
connected to the COM 1 port at the NEO SuiteView side for 
proper communication.

• For TCP/IP connections, use the “ping” command in a DOS 
window to make sure the connection is successful:
a. Open a DOS window (Command Prompt icon in your 

Windows Start menu).
b. Type ping xx.xx.xx.xx, where “xx” is the IP address 

of your NEO frame.
NEO SuiteView Layout Manager User Guide 9
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c. Press Enter.
A DOS message will appear indicating if the connection is 
successful or if it has failed.

Go back to step 9 of the previous section to retry establishing a 
connection. See “Connecting to NEO SuiteView Systems” on 
page 7 for details. 
10 NEO SuiteView Layout Manager User Guide
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The NEO SuiteView Layout Manager Work 
Space

When you have successfully connected to your NEO SuiteView system 
using NEO SuiteView Layout Manager (as described “Connecting to 
NEO SuiteView Systems” on page 7, the Layout Manager main 
window opens. Figure 1-2 illustrates the default view (Manager view) 
of the NEO SuiteView Layout Manager work space. For information 
about the NEO SuiteView Layout Manager Wall view, see “Using the 
Layout Wall View” on page 78.

Figure 1-2. NEO SuiteView Layout Manager Main Window 

Shortcut toolbar

Connection status area

PiP properties paneDevice and preset pane

PiP display window

 NEO SuiteView layout presets
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Each NEO SuiteView Layout Manager work space element is described 
below: 
• Device and Preset pane  Displays the name of the NEO 

SuiteView systems that are currently connected to NEO SuiteView 
Layout Manager. The default display layout presets and any 
customized display layouts are also listed in this pane.

• Shortcut toolbar Provides quick access to commonly used NEO 
SuiteView Layout Manager functions and options. See “NEO 
SuiteView Layout Manager Toolbar Shortcuts” on page 17 for 
toolbar shortcuts names and descriptions. 

• NEO SuiteView layout presets  Provides 10 layout presets that 
can be used for your multiviewer display layout. For more 
information, see “Working With NEO SuiteView Display Layouts” 
on page 55.

• PiP Properties pane  Displays a list of all the modifiable PiP 
properties. For information, see “PiP Properties” on page 58.

• Connection status area  Displays the current connection status 
of the NEO SuiteView systems that are connected to the NEO 
SuiteView Layout Manager software. 

• PiP display window  Displays the currently selected display 
layout. Use this window to view layouts, modifications to layouts, 
and modifications to PiP Properties. For more information, see 
“Working With NEO SuiteView Display Layouts” on page 55.

NEO SuiteView Layout Manager Menus and Toolbar 
Shortcuts 

The following sections describe the NEO SuiteView Layout Manager 
menus, and toolbar shortcuts. In some cases, the menus duplicate 
functions accessible via the toolbar shortcuts (see “NEO SuiteView 
Layout Manager Toolbar Shortcuts” on page 17). Some advanced 
configuration options are only available via the menus.
Note the following menu information:
• Shortcut keystrokes are listed in the selected menu drop-down lists. 
• Commands that are not relevant to the selected mode are 

unavailable.
• Context menus can be accessed by right-clicking items in the 

Device and Preset pane or in the PiP display window.
12 NEO SuiteView Layout Manager User Guide
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The following tables describe each NEO SuiteView Layout Manager 
menu item and its options:
• Table. 1-1. “File Menu Items and Options”  on 13
• Table. 1-2. “Edit Menu Items and Options”  on 14
• Table. 1-3. “Layout Menu Items and Options”  on 15
• Table. 1-4. “PiP Menu Items and Options”  on 15
• Table. 1-5. “Settings Menu Items and Options”  on 16
• Table. 1-6. “View Menu Items and Options”  on 17

Table 1-1. File Menu Items and Options

Menu Item Description
Connect Establishes a connection with the Layout Manager 

software (your PC) and a selected NEO SuiteView 
system. See“Connecting to NEO SuiteView 
Systems” on page 7.

Disconnect Disconnects Layout Manager software (your PC) 
from a selected NEO SuiteView system

Modify Device Opens the Modify Devices dialog box from which 
you can add, remove, and name new 
NEO SuiteView systems. See “Connecting to 
NEO SuiteView Systems” on page 7.

Refresh Devices List Refreshes the selected device list in the Device and 
Preset pane

Display Active File Sends the layout that is currently open in the 
Layout Manager to the output display device

Create File on Server 
Disk

Opens the Create File dialog box from which you 
can add a new layout file to the Server Disk (local 
or network drives).
See “Creating New Display Layouts” on page 72.

Refresh Server Files Refreshes the list of layout files on the local or 
network drive.

Delete Server File Deletes the currently selected layout file from the 
local or network drive

Open Opens a layout file that is stored on the local or 
network drive

Close Closes the currently open layout file
NEO SuiteView Layout Manager User Guide 13
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Save Saves the current layout file to the Server Disk 
(local or network drive). 

Save To Opens the Save To dialog box from which you can 
save a layout file to a NEO SuiteView device list, 
or to a local or network drive

Rename Renames an opened layout file that is in devices list 
or Server Disk

Revert Reverts to the last saved version of an opened 
layout file on either the devices list or the server 
disk (local or network drive); unsaved layout 
changes will be lost

Auto Save Enables periodic, automatic saving of the current 
open layout file 

Import Layout Files Opens the Import Files dialog box from which you 
import layout files from a designated local or 
network drive location

Export Layout Files Opens the Export Files dialog box from which you 
can export multiple layout files to a designated 
local or network drive location

Exit Closes the NEO SuiteView Layout Manager 
application

Table 1-2. Edit Menu Items and Options

Menu Item Description
Undo Removes the last edit operation to the currently 

open layout. Multiple levels of the undo command 
are supported.

Redo Re-instates the last edit operation to the currently 
open layout when the Undo command has been 
used

Table 1-1. File Menu Items and Options(Continued)

Menu Item Description
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Table 1-3. Layout Menu Items and Options

Menu Item Description
Refresh Display Refreshes the display of the currently open layout 

on your PC. It does not affect the output device 
display.

Table 1-4. PiP Menu Items and Options

Function Description
Add/Remove PiP Opens the Add/Remove PiPs dialog box from 

which you can add or removes PiPs from the 
selected layout. See “Adding and Removing PiPs 
From a Layout” on page 73.

Create 2×2 Layout
Create 3×3 Layout
Create 4×4 Layout
Create 5×5 Layout

Applies a quick-format preset layout template to 
the currently open layout See “Quick-Formatting a 
Display Layout” on page 76.

Toggle PiP Properties Toggles the PiP Properties pane (right side) in 
which you can modify individual PiP properties. 
See “PiP Properties” on page 58.

Copy PiP Properties Opens the Copy PiP Properties dialog box from 
which you can copy properties from a selected PiP 
to other PiPs in a layout. See “Copying PiP 
Properties To Other PiPs” on page 68.

Show Preview PiP Enables the PiP preview feature. See “Using the 
PiP Preview” on page 75.

Toggle PiP Grouping Toggles the PiP grouping feature on and off. See 
“Grouping PiPs” on page 77.

Audio Follow Selected 
PiP

Enables audio level monitoring capabilities for the 
selected PiP.
NEO SuiteView Layout Manager User Guide 15



 Chapter 1: Introduction
. 

Table 1-5. Settings Menu Items and Options

Function Description
Display Opens the Display dialog box from which you can 

configure your output display settings. See 
“Configuring Your Output Display Properties” on 
page 23.

Inputs Opens the Input Channel Properties dialog box 
where you can view and modify your input video 
settings. See “Configuring Your Input Channel 
Properties” on page 26.

Audio Opens the following dialog boxes:
• Configuration Provides access to settings 

used to configure audio bar meters. See“Setting 
Up Your Audio Configuration” on page 28.

• Channel Mapping Provides access to audio 
mapping settings. See “Mapping Audio to PiPs” 
on page 33.

Alarms Opens the following dialog boxes:
• Audio Alarm Thresholds Provides access to 

slider controls used to set audio alarm threshold 
values. See “Audio Alarms” on page 35.

• Video Alarm Thresholds Provides access to 
slider controls used to set video alarm threshold 
values. See “Video Alarms” on page 38.

UMD Opens a dialog box which you can use to enter the 
UMD license information and configure UMD 
support. See “Setting Up UMD Support” on 
page 45.

Advanced Opens the Advanced dialog box from which you 
can view NEO SuiteView System information such 
as the unit serial number and the card types 
installed in the system. See “Viewing Your System 
Configuration Information” on page 49.
16 NEO SuiteView Layout Manager User Guide
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NEO SuiteView Layout Manager Toolbar Shortcuts
You can use the NEO SuiteView Layout Manager toolbar shortcuts to 
access frequently used functions. For information about each toolbar 
options, see “NEO SuiteView Layout Manager Menus and Toolbar 
Shortcuts” on page 12.

Clock Setup Opens the Clock Setup dialog box from which you 
can configure the NEO SuiteView clock display. 
See “Configuring the NEO SuiteView Clock 
Display” on page 47.

Turn Off Clock Turns the NEO SuiteView clock display off.

Table 1-6. View Menu Items and Options

Function Description
Toggle Grid Superimposes a grid in the PiP Display window to 

help align and resize PiPs accurately. See “Using 
the Layout Grid” on page 77.

Toggle Wall View Displays the layouts of all NEO SuiteView 
systems currently connected to the NEO 
SuiteView Layout Manager. See “Using the 
Layout Wall View” on page 78

Toggle Extended 
Graphics

Toggles the Extended Graphics mode on and off. 
See “Configuring Your Output Display Properties” 
on page 23.

Table 1-5. Settings Menu Items and Options(Continued)

Function Description
NEO SuiteView Layout Manager User Guide 17
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Figure 1-3 illustrates the NEO SuiteView Layout Manager shortcut 
toolbar. Figure illustrates the shortcut button in the Wall view.

Figure 1-3. NEO SuiteView Layout Manager Toolbar Shortcuts

Open
Add/Remove 
PiPsConnect

Copy 
properties

Toggle PiP 
Grouping 

Toggle 
Grid

Toggle Manager/
Wall view

Toggle PiP 
properties

Create file on 
server disk Define gridSave Toggle Extended 

Graphics mode
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Chapter 2

NEO SuiteView Configuration

Using NEO SuiteView Layout Manager
This section describes how use NEO SuiteView Layout Manager to 
configure your  system, and to select and modify layouts for display. It 
also describes how to modify PiP properties, add audio bar meters to 
your layouts and configure audio and video alarms. The remaining 
sections of this chapter are divided into the following main topics: NEO 
SuiteView system configuration and working with NEO SuiteView 
display layouts. 
Sections on system configuration include: 
• “NEO SuiteView System Configuration Overview” on page 21 
• “Configuring Your Output Display Properties” on page 23 
• “Configuring Your Input Channel Properties” on page 26
• “Configuring Audio” on page 28 
• “Configuring Audio and Video Alarms” on page 35
• “Setting Up UMD Support” on page 45
• “Configuring the NEO SuiteView Clock Display” on page 47
• “Viewing Your System Configuration Information” on page 49 
• “Calibrating Display Devices” on page 51
You can configure your  NEO SuiteView system using a Leitch CCS 
software application such as CCS Pilot or Navigator. For information 
about using your NEO SuiteView Layout Manager with CCS software, 
see your NEO SuiteView Hardware Installation and Operation Manual 
or you CCS software user guide.
NEO SuiteView Layout Manager User Guide 19
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NEO SuiteView Video Inputs, Layouts, and PiPs
Before you begin configuring your NEO SuiteView system, it is 
important to understand the relationship between your NEO SuiteView 
hardware and NEO SuiteView layouts. 
In a NEO frame, NEO SuiteView video inputs are numbered starting 
with the first input module installed in the frame and then continues 
sequentially. NEO SuiteView assigns each PiPs to one of these video 
inputs. Therefore, when PiPs are displayed in a layout, they are 
numbered as PiP1 through to PiP 44, which correspond to video input 1 
through to 44. For example, PiP1 always displays video input 1. This 
assignment of PiP to video inputs cannot be modified. 
The number of video inputs available depends on the NEO SuiteView 
hardware you have installed in your system. The number of PiPs that 
you can display in a layout is directly related to the number of video 
inputs you have in you NEO SuiteView system. If you have a total of 12 
video inputs (3 input modules with 4 inputs each) the maximum number 
of PiPs that you can display in your layout is 16. If you choose a preset 
layout that displays more PiPs then you have inputs, the extra PiPs 
display blue video and a “No Card” message.
The inputs that you use for a display must all come from a single 
SuiteView system. For example, if you have two separate NEO 
SuiteView systems connected to your NEO SuiteView Layout Manager 
software, you cannot choose to use video inputs from both systems in 
the same layout. 
This information should be kept in mind when configuring your NEO 
SuiteView system. 
20 NEO SuiteView Layout Manager User Guide



 Chapter 2: NEO SuiteView Configuration
NEO SuiteView System Configuration Overview
The easiest way to configure your NEO SuiteView system, is to select a 
preset layout display. After you’ve completed the configuration, you 
can choose to use the select preset layout, modify or select another 
preset layout. 

Starting a NEO SuiteView Configuration
NEO SuiteView has 10 default preset layouts (templates) that you can 
choose for your display when configuring your system. The preset 
layout’s PiP properties are set to factory default settings, but they can be 
modified at any time.
You can also create new display layouts (see “Creating New Display 
Layouts” on page 72 for more information). The layout that you use to 
configure your system can be modified or substituted for another layout 
at any time. However, you cannot save a layout (using the Save or Save 
To options) while is it being used as current display layout. 
To start your NEO SuiteView system configuration, from the Device 
and Preset pane, select a preset display layout from the list.

Figure 2-1. Selecting a Preset Layout

After the NEO SuiteView Layout Manager main window opens 
displaying the selected preset layout, you can complete the following 
configuration tasks: 
sections on system configuration include: 
• “NEO SuiteView System Configuration Overview” on page 21 
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• “Configuring Your Output Display Properties” on page 23 
• “Configuring Your Input Channel Properties” on page 26
• “Configuring Audio” on page 28 
• “Configuring Audio and Video Alarms” on page 35
• “Setting Up UMD Support” on page 45
• “Configuring the NEO SuiteView Clock Display” on page 47
• “Viewing Your System Configuration Information” on page 49 
“Calibrating Display Devices” on page 51
22 NEO SuiteView Layout Manager User Guide



 Chapter 2: NEO SuiteView Configuration
Configuring Your Output Display Properties 
You can configure your output display properties, such as selecting an 
output resolution and background color for your output display. Setting 
your output display properties also involves the option of setting up 
NEO SuiteView to operate with external graphics enabled. This is also 
known as configuring your system for Background Graphics mode 
(using external graphics). 
By default, the display processor is responsible for all output timing and 
basic labels, borders, and audio meters. When using external graphic 
(Background Graphics mode), you can optionally connect an external 
graphic input to provide a background image underneath the other 
source windows. The background input allows a wide variety of 
externally generated backgrounds, including labels, textured borders 
(skins), logos, and animations, to be included in the multi-window 
display. 
See Step 7 on page 24 for instructions on how to configure your NEO 
SuiteView system to use internal graphics (Standalone mode) or 
external graphics (Background Graphics mode). 
To set your output display properties, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Display. 
The Display dialog box opens.
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2. Under Output, select a video output resolution video from the 
Standard list. Output resolutions are expressed as 
height×width×frequency.
When choosing an output resolution for a high-quality output, 
select an output display resolution that matches the native 
resolution of the output display device.

3. Under Frequency Adjust, adjust the frequency of your output 
display device. 

4. Click Background Color to select a color for the background of 
your output display. 
The Select a Color dialog box opens.

5. Double-click a color from the palette, and then click OK.
6. Under Genlock, select Show External Graphics if you want to 

enable the External Graphics option (Background Graphics mode). 
When using the external graphics option, system timing and 
resolution are forced to match the externally applied graphic input. 
Typically, this means that resolutions from 1024 × 768 up to UXGA 
(1600×1200) will be used as the output display resolution.

7. If you selected the Show External Graphics option, you can also 
make the following selections: 
• Show Internal Graphics Select this option if you want to 

show NEO SuiteView generated graphics, such as labels and 
boarders.
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• Enable Genlock AutoDetection Select this option if you 
want NEO SuiteView to automatically detect and use the 
resolution of a genlock input. Leitch recommends leaving this 
feature enabled unless the system is attempting to genlock to an 
unsupported resolution.

• Background Graphics Phase Adjust Use the slider to 
adjust the phase of the external background graphics. 

8. Click OK to save your output display properties. 
Before you use your NEO SuiteView system in the broadcast 
environment, it is recommended that you calibrate your output display 
device. For information about calibrating your output display device, 
see “Calibrating Display Devices” on page 51.
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Configuring Your Input Channel Properties
By default, NEO SuiteView detects the type, standard, and format of 
each input video channel. However, you can access the input channel 
properties and manually change these settings. Since PiPs are directly 
associated with a video channel, the input channel properties apply to 
each corresponding PiP. In the Input Channel Properties dialog box, 
each video channel is represented by a PiP number. 
To change the input channel properties, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Inputs.
The Input Channel Properties dialog box opens. 

Note
When you click under Type, Standard, and Format, a drop-down list 
appears from which you can select options.

2. Under Auto Detection, select this option if you want NEO 
SuiteView to detect the Type, Standard, and Format of an input 
video channel. 
By default, the Auto Detection option is enabled. If you want to 
manually set the Type, Standard, and Format for a PiP, you must 
clear this option.

3. To change the type of video for a PiP (video channel), under Type, 
click beside the PiP you want to change, and then select a video 
type from the list.
26 NEO SuiteView Layout Manager User Guide



 Chapter 2: NEO SuiteView Configuration
4. To change the video standard for a PiP (video channel), under 
Standard, click beside the PiP you want to change, and then select 
a video standard from the list. 
The options available from the Standard list depend on the video 
type of the selected PiP (input channel). For example, if a PiP’s type 
is HD Video, then 1080i and 720p are the only options available 
from the Standard list.

5. To change the video format for a PiP (video channel), under 
Format, click beside the PiP you want to change, and then select a 
video format from the list.
The options available from the Format list depend on the video 
standard of the selected PiP (input channel). For example, if a PiP’s 
standard is 1080i, then SDI is the only option available from the 
Format list

6. Under Default Crop, select this option to prevent crop settings 
from being made in the PiP Properties pane for the selected PiP.
By default, the Default Crop option is enabled. If you want to apply 
crop settings to a PiP (video input) using the PiP Properties pane, 
you must clear this option. 
For information about the PiP Properties pane, see “A typical 
plasma display will have both sampling frequency and phase 
adjustments accessible from a menu on the display device itself. In 
general it is recommended to adjust the display device’s sampling 
frequency to remove any vertical banding patterns. Only then 
should the display device’s sampling phase be adjusted so that each 
individual pixel of the checkerboard is visible.” on page 54. 

7. Click OK to save your input channel properties.
NEO SuiteView Layout Manager User Guide 27



 Chapter 2: NEO SuiteView Configuration
Configuring Audio
If you are using embedded audio or have an NVS-AUD16-FM or 
AES16-FM installed or connected to your NEO SuiteView system, you 
can associate up to eight individual audio channels (or four channel 
pairs) to each PiP for monitoring purposes. Audio alarm and bar meters 
for each of these assigned channels is overlayed on the left and right 
sides of a PiP. A typical arrangement will have two groups of four bar 
meters on each side, although you can choose any number of channels 
to monitor (to a maximum of eight). You can configure how the audio 
bar meters appear in the PiP, and choose in which PiPs you want to 
place audio bar meters. 

Note
If you are using embedded audio, you must enable your embedded 
audio license before configuring the audio. For information about 
enabling your embedded audio license, see “Enabling Embedded 
Audio Support” on page 50.

The following sections describe how to use the Audio Configuration 
and Channel Mapping dialog boxes, to configure your NEO 
SuiteView system to display audio bar meter and audio alarms within a 
selected layout.

Setting Up Your Audio Configuration
Using the Audio Configuration dialog box, you can define the layout 
properties for the audio bar meters. Settings that are configured using 
the Audio Configuration dialog box are globally applied to each PiP in 
the layout. You can then choose to enable or disable audio metering for 
individual PiPs using the Audio Mapping dialog box (See “Mapping 
Audio to PiPs” on page 33 for information). 

Note
You must either be using embedded audio, or have an 
NVS-AUD16-FM installed or connected to your NEO SuiteView system 
to configure audio bar meters.

To access the Audio Configuration dialog box, from the NEO 
SuiteView Layout Manager main menu, select Settings > Audio > 
Configuration.
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The Audio Configuration dialog box is displayed:

Selecting Audio Display Options
Under Display, you can choose the audio metering display options that 
you want to use for the layout. To select your audio display options, 
from the Audio Configuration dialog box, make the selections:

• Meter Select this option to display audio bar meters for each 
audio channel you associate with a PiP

• Alarms Select this option to globally enable on-screen audio 
alarms within associated PiPs

• Scale Select this option to display graduated numeric scales 
along with the audio bar meters

Selecting Audio Metering Options

Under Analog/AES Inputs, you choose the type of audio bar meters 
you want to use in your PiPs and configure the color orientation of the 
audio meter scales. There are six bar/scale types that you assign to your 
input audio channels: BBC, DIN, VU, VU-EXT, NORDIC and AES/
EBU. 

Note
If you are using an SDI embedded audio source, only AES/EBU bar 
meters are available. 
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Figure 2-2 illustrates the appearance of each available audio bar meter 
type. 

Figure 2-2. Available Audio Bar Meters

Each audio bar meter type has default red-yellow and yellow-green 
transition points. These transitions points can be modified to suite your 
audio sources. For example, you can customize the transition point, in 
percentage of the overall meter height, of where the yellow portion of 
the meter turns to red (see steps 2 and 3 below for more information). 
Each audio bar meter types has its own properties, such as scale and 
dynamic range. Table 2-1 lists important specifications about each type 
of audio bar meter.

Red-Yellow 
transition point

Yellow-Green 
transition point

Table 2-1. Audio Bar Meter Dynamic Range and Ballistics

Scale Dynamic Range Attack 
Time Decay Time

BBC 24 dB 
+12 dB to -12 dB

10 msec per 
80%

2.8 sec per 24 dB decay

DIN 55 dB 
+5 dB to -50 dB

10 msec per 
90%

1.5 sec per 20 dB decay

VU 23 dB 
+3 dB to -20 dB

300 msec per 
99%

300 msec/1%
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To set your audio configuration settings, follow these steps:
1. Beside Standard, select the audio metering type that you want to 

use from the list. 
See Figure 2-2 and Table 2-1 for information about available audio 
bar types. 

2. Beside Red-Yellow, use the controls to set the transition point, in 
percentage of the overall meter height, where the yellow portion of 
the meter turns to red. Typically, the red-yellow transition 
corresponds with 0 dB on analog audio scales. 

3. Beside Yellow-Green, use the controls to set the transition point, in 
percentage of the overall meter height, where the green portion of 
the meter turns to yellow.

4. Click OK to save your settings or continue to the next section.

Setting Audio Bar Position and Width
Under Audio Bars Position, you can specify where the audio bar 
meters are positioned within PiPs. You can also specify the width of the 
audio meter color bar. 

VU-EXT 80 dB 
+10 dB to -70 dB

300 msec per 
99%

300 msec per 1%

NORDIC 54 dB 
+12 dB to -42 dB

10 msec 1.7 sec per 20 dB decay

AES/
EBU

60 dB 
0 to -60 dB

One sample 1.5 sec per 20 dB decay

Table 2-1. Audio Bar Meter Dynamic Range and 
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There are four control settings, yTop, XPos, yBot, and Bar Width that 
you can use to specify the position and width of the audio bars within 
the PiP. These settings are global for all the PiPs in the layout in which 
you want audio bar meters to appear. Figure 2-3 illustrates each of the 
audio bar position settings that you can configure.

Figure 2-3. Audio Bar Positioning

To set your audio bar positions and width, under, Audio Bars Position, 
use the controls to specify the position and width of the audio bars in 
your PiPs. 

Figure 2-4. Audio Bar Position Control Settings

Click OK to apply your audio configuration settings.
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Mapping Audio to PiPs
Using the Audio Mapping dialog box, you can select which audio 
channels you want to monitor, and select in which PiP you want audio 
bar meters to appear. 
To map your audio channels to PiPs follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Audio > Channel Mapping.
The Audio Mapping dialog box is displayed:

2. Beside Board No., select the NSV-AUD16-FM module that you 
want to map. 
For embedded audio, select 0.

3. Each audio channel associated to the selected Board No is assigned 
a channel number. To configure audio mapping settings for each 
audio channel (Channel Number), make the following selections: 
a. Under PiP No select the PiP that you associate with the 

Channel Number (audio channel). 
You can select a maximum of eight audio channels for each PiP.
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b. Under Bar Position, select the audio bar that you want to 
assign to the Channel Number (audio channel). 
See Figure 2-4 on page 32 for an illustration of audio bar 
position.

c. To enable or disable audio metering for a Channel Number 
(audio channel), under On/Off, select (enable) or clear 
(disable) the check box.
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Configuring Audio and Video Alarms
You can configure NEO SuiteView Layout Manager to display audio 
and video alarms on each PiP in a layout. When you configure alarms, 
you can globally specify threshold values that trigger an alarm 
condition which is then displayed in a layout PiP. Figure 2-5 illustrates 
a PiP with audio and video alarms displayed. 

Figure 2-5. Audio and Video Alarms

Audio Alarms
There are two audio alarms that you can enable for each PiP: Audio 
Overlevel and Audio Underlevel. Details about each alarm is described 
below:
• Audio Overlevel Alarm Indicates that the input audio level of 

the audio channel is above the set upper threshold dB values; in the 
alarm display an overlevel alarm is represented by an “O” 

• Audio Underlevel Alarm Indicates that the input audio level of 
the audio channel is below the set lower threshold dB values for 
more than the user-defined maximum time; in the alarm display an 
underlevel alarm is represented by an “U”

Video alarm displayed

Audio alarm displayed
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For information about setting threshold values for overlevel and 
underlevel audio alarms, see “Setting Audio Alarms Threshold Values” 
on page 37. 
Figure 2-6 describes the audio alarm display.

Figure 2-6. Audio Alarm Display Description

Enabling Audio Alarms
Audio alarms are enabled and disabled in the NEO SuiteView Layout 
Manager PiP Properties pane. You can choose to enable alarms for 
individual PiPs or for all the PiPs in a layout. 
To enable audio alarms, follow these steps:
1. To access the PiP Properties pane, select PiP > Toggle PiP 

Properties from the NEO SuiteView Layout Manager main menu. 
OR
Click the Toggle PiP Properties icon from the NEO 
SuiteView Layout Manager toolbar. 

2. From the PiP Properties pane, click the Alarm Settings tab. 
3. In the PiP display window, select the PiP for which you want to 

enable audio alarms.

Overlevel 
alarm on 
channel 1 

No alarm on 
channel 2 

Under level 
alarm on 
channel 3 

No alarm on 
channel 4 
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4. On the Alarm Settings tab, under Audio, select the audio alarms 
you want to enable. 

Figure 2-7. Selecting Audio Alarms

5. To enable the selected audio alarms on all the PiPs in the layout, 
click Copy to all pips. 

For information about setting threshold values for the enabled audio 
alarms, see the next section.

Setting Audio Alarms Threshold Values
Using the Audio Alarm Thresholds dialog box, you can set the global 
threshold values for the Audio Overlevel, Audio Underlevel, and Audio 
Underlevel Delay. When one of the current input audio levels (in dB) is 
equal to or greater than the overlevel threshold values (in dB), the 
Audio Overlevel alarm is triggered. When one of the current input 
audio levels (in dB) is less than or equal to the underlevel threshold 
value (in dB) for a period of time that exceeds the user-defined 
underlevel delay, the Audio Underlevel is triggered.

Note
The audio alarm threshold values apply to all input audio channels. You 
cannot specify threshold values for individual audio channels. Audio 
alarms must be enabled in the Audio Configuration dialog box and 
Alarm Settings tab of the PiP Properties pane and before they appear 
in individual PiPs. For more information, see “Setting Up Your Audio 
Configuration” on page 28 and “Enabling Audio Alarms” on page 36.
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To set your audio alarm threshold values, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Alarms > Audio.
The Audio Alarm Thresholds dialog box opens:

2. Under Overlevel, use the slider (or enter a value) to set the audio 
overlevel threshold value. 

3. Under Underlevel, use the slider (or enter a value) to set the audio 
underlevel threshold value. 

4. Under Underlevel delay in seconds, use the slider (or enter a 
value) to set the maximum time (in seconds) an audio input level 
can be at the underlevel threshold value. 

5. Click OK to save your settings. 

Video Alarms
There are three video alarms that you can enable for each PiP: loss of 
sync, frozen picture, and black picture. When an input video signal 
triggers an alarm, an alarm message is displayed in the associated PiP 
(see Figure 2-5 on page 35).
Details about each alarm are described below:
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• Loss of sync alarm Indicates that NEO SuiteView can no longer 
detect a video signal from the video channel.

• Frozen picture alarm Indicates that the input video image is 
frozen (static) according to user-defined frozen picture delay and a 
frozen picture error threshold values. When the alarm is triggered, a 
Frozen Picture message is displayed in a PiP.

• Black picture Indicates that the input video image is considered 
a black picture according to user-defined percentage non black 
picture and black level threshold values. When the alarm is 
triggered, a Black Picture message in a PiP. 

For information about setting video alarm threshold values, see “Setting 
Video Alarm Threshold Values” on page 40. To enable video alarms, 
see the next section. 

Enabling Video Alarms
Video alarms are enabled in the NEO SuiteView Layout Manager PiP 
Properties pane. You can choose to enable alarms for individual PiPs 
or for all PiPs in a layout. 
To enable video alarms, follow these steps:
1. To access the PiP Properties pane, select PiP > Toggle PiP 

Properties from the NEO SuiteView Layout Manager main menu. 
OR
Click the Toggle PiP Properties icon from the NEO 
SuiteView Layout Manager toolbar. 

2. From the PiP Properties pane, click the Alarm Settings tab. 
3. In the PiP display window, select the PiP for which you want to 

enable audio alarms.
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4. On the Alarm Settings page, under Video, select the video alarms 
you want to enable. 

Figure 2-8. Selecting Video Alarms

5. To enable the selected video alarms on all the PiPs in the layout, 
click Copy to all pips. 

For information about setting threshold values for the enabled video 
alarms, see the next section.

Setting Video Alarm Threshold Values
Using the Video Alarm Thresholds dialog box, you can set the global 
threshold values that trigger Frozen Picture and Black Picture video 
alarms. 
To determine if a video image is frozen, NEO SuiteView uses the 
combination of frozen picture delay and percentage error (in the frozen 
image) threshold values. Each threshold value is described below:
• Frozen Picture Delay Defines the maximum time (in seconds) a 

picture can be frozen or static before it is considered frozen. 
• Frozen Picture- Percentage Error Allowed Defines an error 

value (in percent) that compensates for motion that is detected in 
the frozen video image. This motion can be caused if the video is 
frozen between two video fields or video frames.

To determine if a video image is a black picture, NEO SuiteView uses 
the combination of black picture delay, percentage of non-black, and 
black level threshold values. Each of threshold values are described 
below:
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• Black Picture Delay Defines the maximum time (in seconds) a 
picture (video image) can be “black” before triggering a Black 
Picture alarm. A black picture is defined by percentage of 
non-black picture and black level. 

• Percentage of Non-Black Picture Defines the percentage of the 
video picture that is not black, according to the black level amount 
of an error value (in percentage), that compensates for motion that 
is detected in the frozen video image. This motion can be caused if 
the video is frozen between two video fields or video frames.For 
example, when a video image is frozen between two video fields or 
frames, some motion may be detected

• Black Level Defines the IRE level that the picture is considered a 
black picture.

Note
The video alarm threshold values apply to all input video channels. You 
cannot specify threshold values for individual video channels. Video 
alarms must be enabled in the Alarm Settings tab of the PiP 
Properties pane before they appear in individual PiPs (see “Enabling 
Video Alarms” on page 39). 

To set your audio alarm threshold values, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Alarms > Video.
The Video Alarm Thresholds dialog box opens:
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2. Under Frozen Picture delay in seconds, use the slider (or enter a 
value) to set the maximum time (in seconds) a picture (video 
image) can be frozen (static) before triggering a Frozen Picture 
alarm.

3. Under Frozen Picture- Percentage Error Allowed, use the slider 
(or enter a value) to set a percentage error value to compensate for 
motion in a frozen picture.

4. Under Black Picture delay in seconds, use the slider (or enter a 
value) to set the maximum time (in seconds) a picture (video 
image) can be “black” triggering a Black Picture alarm. The Black 
Level and Percentage of non-black picture are used to define a 
‘black” picture.

5. Under Percentage of non-black picture, use the slider (or enter a 
value) to set a value for percentage of non-black picture. The Black 
Level setting defines whether a picture is consider a non-black 
picture.

6. Under Black level, use the slider (or enter a value) to set the IRE 
level that defines whether or not the picture (video image) is 
considered a “black” picture. 
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7. Click OK to save your settings.
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Configuring Under Monitor Display (UMD)
 NEO SuiteView offers optional under monitor display (UMD) support. 
This provides a protocol interface (via RS-232, RS-422, or RS-485) to 
different third-party routing switcher protocols in order to input 
in-picture UMD source identification and tally status information. This 
information automatically updates on screen when the source is 
updated. NEO SuiteView supports up to two UMD captions per PiP, 
each consisting of up to five alphanumeric characters.

Note
Before using an RS-422 UMD device with NEO SuiteView, you must do 
the following:

• You must connect a RS-422 UMD device to the COM2 port of 
the NEO SuiteView back panel. You cannot use the COM1 port 
for RS-422 devices. 

• You must enable the COM2 port by setting the COM1_COM2 
parameter to either OFF+TSL or CMD+TSL. 

For more information about making UMD connections, switching your 
NEO SuiteView system to RS-485 mode, and optional UMD support 
and configuration, see your NEO SuiteView Hardware Operation and 
Installation Manual.

Note
Contact your Leitch customer service representative for new 
information about interfacing with other third-party router 
manufacturers.

Tally lamps are useful in knowing which video feed is being output to 
the display. When a GPI input is shorted to its respective ground, the 
corresponding video window (PiP) will have a tally lamp in the corner. 
A red tally lamp indicates that GPI 1 is closed, while a green tally lamp 
indicates that GPI 2 is closed. 
For information about connecting GPI devices to your NEO SuiteView 
system, see your NEO SuiteView Hardware Operation and Installation 
Manual.
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Setting Up UMD Support
To following sections describe how to enable UMD support for your 
NEO SuiteView system, and how to set the RS485 Base Address for 
UMD display data.

Entering Your UMD License Key and Enabling Support
Before you can use the UMD support that you purchased, you will need 
the enter the UMD license key. If you have not purchased a UMD 
support for NEO SuiteView, contact your customer service 
representative.
When UMD support is enabled, PiP label text and tally information is 
determined by a router destinations or sources via a TSL controller. 
When UMD support is disabled, the PiP label text comes from the NEO 
Layout Manger.
To enter the UMD licence number key and enable UMD support, follow 
these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > UMD.
The UMD Setup dialog box opens:

2. Beside Invalid UMD Licence, enter the UMD license key.
If your license number is valid, the Invalid UMD License label 
changes to Valid UMD License.

3. To enable UMD, select Enable UMD.
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Entering an RS-485 Base Address
You can send UMD data to more than one NEO SuiteView system. To 
do this, you need to enter an address in the RS485 Base Address box of 
the UMD Setup dialog box. This address is used to identify which 
UMD display data you want to send to the first PiP of each NEO 
SuiteView system. In general, the RS485 Base Address is the start 
address for UMD display data.
For example, if you have 16 addresses of UMD display data that you to 
send to two NEO SuiteView systems (8 addresses to each system), 
make the following selections:
• Use 0 as the RS485 base address first system to send UMD data 

(addresses 0 to 7) to PiPs one through eight (on NEO SuiteView 
System one).

• Use 8 as the RS485 base address second system to send UMD data 
(8 to 16) to PiPs one through eight (on NEO SuiteView System 
two).

Note
If you are using UMD display data that is coming from a serial protocol 
Translator (SPT), the first UMD data address is 1 not 0.

Prior to entering an RS-485 base address, you need to ensure that the 
proper RS-485 connection is made between your  and UMD devices, 
and that you are in RS-485 mode. See Appendix C: “UMD/Tally 
Option” for more information.

Note
This feature is not applicable to applications with RS-232 serial 
connections.
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Configuring the NEO SuiteView Clock Display
You can configure your NEO SuiteView system to display an on-screen 
clock within the layout. Depending on the size of the clock you choose 
to add to your layout, the clock will either be superimposed over an 
existing PiP image, or it will cover the underlying PiP image 
completely. The NEO SuiteView clock can be configured to accept time 
code from an external time code generator as a time source. Otherwise, 
the clock is driven by the output module’s internal clock. 

Note
If you want to use an external LTC source to drive the NEO SuiteView 
clock, you must do the following:

• You must connect the LTC source to the COM2 port of the 
NEO SuiteView back panel. You cannot use the COM1 port for 
LTC sources. 

• You must enable the COM2 port by setting the COM1_COM2 
parameter to either OFF+LTC, CMD+TSL, or TSL+LTC. 

The NEO SuiteView clock can be disabled at any time by selecting 
Settings > Turn off Clock from the NEO SuiteView Layout Manager 
main menu. 
To set up the NEO SuiteView clock, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select 

Settings > Clock Setup.
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The Clock Setup dialog box is displayed:

2. Under Time Zone, set any time zone offsets you require for the 
clock. 

3. If you want to a name to appear with your clock, in the Title field, 
enter a name that you want to appear, and then select ON. 

4. Beside Select Clock Size, select a clock size
5. Under Multiviewer Time, set the clock’s time, and then click Set 

Time, and then click OK.
48 NEO SuiteView Layout Manager User Guide



 Chapter 2: NEO SuiteView Configuration
Viewing Your System Configuration 
Information

In the Advanced dialog box, you can view a summary of your NEO 
SuiteView system configuration and enter embedded audio license 
information. A listing of the card types installed in the system and the 
number of the frame slot in which they are installed is also provided in 
the Advanced dialog box. You can select test patterns to calibrate your 
display device. See, “Configuring Your Input Channel Properties” on 
page 26 for more information. You can also recall factory default values 
from the Advanced dialog box. 
To access the Advanced dialog box, from the NEO SuiteView Layout 
Manager main menu, select Settings > Advanced. 
The Advanced dialog box opens.

Figure 2-9. Advance Dialog Box. 
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Enabling Embedded Audio Support
Before you can use the embedded audio support you purchased for 
NEO SuiteView, you will must enter the embedded audio license key in 
the Advanced dialog box. If you have not purchased embedded audio 
support for NEO SuiteView, contact your customer service 
representative.
To enter the, embedded audio licence key, follow these steps:
1. In the Advanced dialog box under Value, select the box beside 

Embedded Audio License. 
2. Enter your embedded audio license key in the box.

Figure 2-10. Enter Embedded Audio License Key 

When you enter a valid embedded audio license key, the No. of 
Embedded Audio Channels licensed box is updated with the 
number of embedded audio channels purchased. 

3. Click OK.
When you enter a valid embedded audio license key, the No. of 
Embedded Audio Channels licensed box is updated with the number 
of embedded audio channels purchased and supported. For example, if 
you have purchased an license for 32 channels of embedded audio, but 
have hardware installed in your NEO SuiteView that supports only 16 
channels, the No. of Embedded Audio Channels licensed box 
displays 16 and not 32.
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Calibrating Display Devices
It is important to calibrate the attached output display device (not the  
output signal) to obtain the optimum clarity for the overall output 
picture. Calibration is particularly important for digital display devices, 
such as plasmas and LCDs.
NEO SuiteView Layout Manager has test patterns that can help you 
calibrate your output display device. These test patterns include Grey 
Scale for contrast adjustments, CheckerBoard for sample frequency 
and phase adjustment, Black for brightness adjustment, and Color Bar 
for color adjustment. To calibrate your display, you can output these test 
patterns from NEO SuiteView and make appropriate adjustments using 
the display device’s adjustment controls. 

Caution
It is imperative that the cables used to connect displays consist of high 
quality multiple 75Ω coaxial cable, preferably with RFI screening ferrite 
collars at each end. On no account should unscreened or twisted pair 
cable be used in preference to 75Ω video cables. Incorrect cables will 
cause severe ghosting and noticeable image degradation.

To calibrate an attached output display device, follow these steps:
1. If you have not already done so, determine the native display 

resolution of the display device, and then do one of the following:
• If set the output display resolution  as explained in step 2 on 

page 24 (See “Configuring Your Output Display Properties” on 
page 23).

OR
• If you’ve selected the Show External Graphics option 

(Background Graphics mode) when configuring your output 
display properties, select an external background image that has 
the same resolution as the native resolution of the display 
device. Configure your External Graphics settings as explained 
in step 8 on page 24. (See “Configuring Your Input Channel 
Properties” on page 26.)

2. From the NEO SuiteView Layout Manager main menu, select 
Settings > Advanced.
The Advanced dialog box opens. 
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3. In the Value column. click Calibrate off, to open the Test Pattern 
list.

Figure 2-11. Selecting a Test Pattern

The following sections describe how to calibrate your output display 
device contrast level, brightness level, color levels as well as frequency 
and phase.

Setting Your Display Device Contrast
Using the Gray Scale test pattern, you can calibrate your display 
device’s contrast level. To calibrate your displays device’s contrast 
level, follow these steps. 
1. Select Gray Scale from the Test Pattern list.

This creates a grey scale ramp pattern across the display, with black 
on the left side and white on the right side.

2. Using your display device’s adjustment controls, set the device’s 
contrast so that the ramp is uniformly distributed across the whole 
display.

Setting Your Display Device’s Brightness
Most NEO SuiteView systems typically display video rather than 
computer data on an output display. For this reason, the display device 
brightness control should be adjusted so that it is optimized to render 
video on the display. To adjust your display device brightness settings, 
follow these steps:
1. Select Black from the Test Pattern list.

This test pattern is used to adjust the brightness of the display so 
that video detail near black is not lost “below the display black” and 
remains visible. This pattern fills the display with a uniform black 
color of RGB (16,16,16). This value has been chosen because this 
is the absolute minimum black color allowed in a PAL or NTSC 
video signal.
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2. Adjust the device’s brightness control until a uniform black color is 
achieved.

Setting Your Display Device’s Color
Using the Color Bar test pattern, you can set the color temperatures of 
your display device. To adjust your display device color settings, follow 
these steps:

1. Select Color Bar from the Test Pattern list.
This pattern outputs a standard color bar. This pattern can be used 
to adjust the color temperature of the display device.

2. Adjust the device’s color control until the proper color temperatures 
are displayed.

Setting Your Display Device Sample Frequency and Phase
Using the Checkerboard test pattern, you can set the sampling 
frequency and phase of your analog display device. To adjust your 
display device frequency and phase settings, follow these steps:
1. Select CheckerBoard from the Test Pattern list.

This creates a pattern on the output display of alternate white black 
pixels.

Note
If your output display device is a plasma screen, it may vertically 
squeeze the image; in this case, the checker board pattern may appear 
as a flat gray field or a series of one pixel thick vertical lines. See “Why 
Does the Checker Board Test Pattern Not Look Right on a Plasma 
Monitor?” in the Trouble Shooting chapter of this manual for more 
information.

2. To optimize the display device sample frequency, adjust the 
attached display’s frequency (sometimes called “width”.) to remove 
any vertical interference banding patterns. 

3. Adjust the display’s phase (sometimes called “height”) until each 
individual pixel of the checkerboard pattern can be seen.

If the phase is completely out of calibration, the checkerboard pattern 
may appear as a series of horizontal lines.
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Considerations When Using an Analog Interface
If you are using an analog display device, check the native resolution 
supported by the plasma or LCD screen in use and configure the output 
to be the same in Standalone mode. Use the CheckerBoard pattern to 
calibrate the display. If there is even a slight difference in resolution, the 
output display device is forced to perform its own internal scaling and 
interpolation. This may result in soft images or other artifacts that may 
adversely affect the output quality.

Note
When the phase is completely miscalibrated, the checkerboard pattern 
will appear as a series of horizontal lines. If the plasma is in vertical 
squeeze mode, it will appear as a flat gray field or a series of 1-pixel 
thick vertical lines

A typical plasma display will have both sampling frequency and phase 
adjustments accessible from a menu on the display device itself. In 
general it is recommended to adjust the display device’s sampling 
frequency to remove any vertical banding patterns. Only then should 
the display device’s sampling phase be adjusted so that each individual 
pixel of the checkerboard is visible.
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Chapter 3

Layouts and PiPs

Working With NEO SuiteView Display Layouts
Using NEO SuiteView Layout Manager, you can select, modify, and 
create NEO SuiteView display layouts. Depending on the NEO 
SuiteView hardware that you have installed in your system, display 
layouts can be comprised of up to 44 picture-in-picture (PiP) images 
(up to 44 input channels). The display characteristics of a layout are 
determined by the individual PiP properties, such as the size, position, 
color, and border size. See “PiP Properties” on page 58 for information 
about PiP properties.
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A maximum of 10 preset layouts can be saved on your NEO SuiteView 
system at one time. Figure 3-1 illustrates how some of the provided 
preset display layouts are arranged. In the illustration, each number 
represents a PiP (or video input channel). 

Figure 3-1. Preset Display Layouts

Table 3-1 describes the Layout Manager display preset PiP 
arrangement. 
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Table 3-1. Default Preset Descriptions

 Preset Display
2×2 2 picture tile rows, 2 picture tile columns

3×3 3 picture tile rows, 3 picture tile columns

4×4 4 picture tile rows, 4 picture tile columns
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5×5 5 picture tile rows, 5 picture tile columns

6×6 6 picture tile rows, 6 picture tile columns

12+1 13 picture tiles, with one of the following location 
variations for the included 6×6 PiP:
• center of display
• bottom left corner of display
• bottom right corner of display

Table 3-1. Default Preset Descriptions

 Preset Display
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PiP Properties
Each PiP has a number of associated properties that determine how PiP 
are displayed in the layout. PiP properties can be modified and then 
copied between PiPs. This means that you can modify the PiP 
properties of a preset display layout to create a customized layout which 
can then be renamed and saved to NEO SuiteView or to the Server 
Disk (a local or network drive). PiP properties cannot be modified via 
card-edge, a control panel, or a CCS software application such as CCS 
Pilot or Navigator. 3-2 illustrates a display layout and its associated 
layout and PiP elements that can be modified.
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Figure 3-2. Typical PiP Attributes for Audio Meters, Alarm Data, Border, and Labels 

Using the PiP Properties pane, you can display and modify a display 
layout’s PiP properties. To access the PiP Properties pane, select 
PiP > Toggle PiP Properties from the NEO SuiteView Layout 
Manager main menu. 

Change PiP label position, 
size, and color; change 
position, size, and color of 
text on the label

Add audio bar metersChange PiP border 
color and size

Change background colorChange PiP size and 
position

Add NEO SuiteView clock Display audio alarms

Display video alarms
NEO SuiteView Layout Manager User Guide 59



 Chapter 3: Layouts and PiPs
Using Preset Display Layouts
The easiest way to use NEO SuiteView as a multiple display viewer, is 
to use one of NEO SuiteView preset display layouts (see “Working 
With NEO SuiteView Display Layouts” on page 55 for information 
about preset display layouts). The preset display layouts have been 
created to optimize the available display area for each layout 
arrangement. It is recommended that you do not modify the preset 
display layouts. Instead, you can use a preset display layout as a starting 
point in creating a custom layout. Custom display layouts can be saved 
to the Server Disk (a local or network drive) and then loaded into the 
NEO SuiteView system. This way, you will avoid overwriting one of 
the ten preset layouts that are (by default) loaded into your NEO 
SuiteView system. 
To use a preset display layout, you must be connected to a NEO 
SuiteView system as described in “Connecting to NEO SuiteView 
Systems” on page 7. 
For best results, it is recommended that you configure your display 
devices as described in “Configuring Your Output Display Properties” 
on page 23 and configure your NEO SuiteView system’s input video 
settings as described in “Configuring Your Output Display Properties” 
on page 23. 
For information about modifying a preset layout to create a custom 
layout, see “Modifying Preset Display Layouts To Create Customized 
Layouts” on page 62. 
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Selecting a Preset Display Layout 
To select a preset layout to use as a layout display, from the NEO 
SuiteView Layout Manager’s Device and Preset Pane, select a preset 
layout from the list.

Note
To use a preset display layout, you must be connected to a NEO 
SuiteView system as described in “Connecting to NEO SuiteView 
Systems” on page 7. 
The display layout you select opens in NEO SuiteView Layout 
Manager displaying PiPs of your video inputs.

You can at any time make adjustments to your system settings, such as 
changing video input formats and alarm configurations, without 
modifying the preset layout. To modify your system settings, see the 
following:
• To change your output display settings, see “Configuring Your 

Output Display Properties” on page 23
• To change your input settings, see “Configuring Your Input 

Channel Properties” on page 26
• To change your audio settings or audio mapping, see “Configuring 

Audio” on page 28
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• To change you audio or video alarm settings, see “Configuring 
Audio and Video Alarms” on page 35.

• To change your UMD settings, see “Configuring Under Monitor 
Display (UMD)” on page 44.

• To change your NEO SuiteView clock settings, see “Configuring 
the NEO SuiteView Clock Display” on page 47.

Modifying Preset Display Layouts To Create Customized 
Layouts

You can create a custom layout from a preset layout by modifying the 
properties of each PiP in the layout. After you complete the 
modifications to the layout, you can rename it and then save it to the 
Server Disk (local or network drive). Although custom display layouts 
can be saved directly to the NEO SuiteView system, it is recommended 
that you save them to the Server Disk (local or network drive). This 
will avoid overwriting one of the ten preset layouts that are (by default) 
loaded into your NEO SuiteView system. Your customized display 
layout can then be loaded from the Server Disk (your local or network 
drive) to your NEO SuiteView system.

Note
If you want to create a custom layout by modifying one of the default 
preset layouts, save the layout using a new name before you begin 
modifying the layout.

You can use PiP Properties pane of the Layout Manager software to 
modify all of a PiP’s properties. Modifications to some PiP properties 
such as increasing the size of the PiP or changing the PiP’s location 
within the layout can be done using your computer’s mouse. 

Note
If you are using your computer mouse to move PiPs in a layout, you 
can use the PiP grouping option to move multiple PiPs simultaneously. 
For about using the PiP grouping option, see “Grouping PiPs” on 
page 77.

Table 3-2 provides a list of PiP properties that you can modify using the 
PiP Properties pane. PiP property default settings are indicated by an 
asterisk (*). See “General Guidelines For Resizing and Editing PiPs” on 
page 66 for information about using your computer mouse to modify 
PiP properties. 
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Table 3-2. Modifiable PiP Properties 

Property Description Options
Label

Text Changes the text on the PiP label Maximum of 19 (*single digit 
identifier)
You can use the following 
characters in the label text: 
• all letters
• all numbers
• !
• (
• )
• _

Visible Enables/disables the PiP label display • Enable*
• Disable

Label x Sets the horizontal position (in pixels) 
of the PiP label (changing this option 
will override the label justify setting)

1 to 376 (*204, centered)

Label y Sets the vertical position (in pixels) of 
the PiP label

1 to 306 (*304, bottom)

Label width Sets the width of the PiP label Variable, depending on label x/
horizontal position of PiP label 
(*40)

Label height Changes the height of the PiP labels Variable, depending on label y/
vertical position of PiP label 
(*24)

Text x Sets the horizontal position of the text 
on the PiP label. (changing this option 
will override the label text justify 
setting)

Variable, depending on the label 
width and label x/horizontal 
position (*0)

Text y Sets the vertical position of the text on 
the PiP label

Variable, depending on the label 
height and label y/vertical 
position (*24)
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Label justify Justifies the position of the PiP label 
horizontal position (changing this 
option will override the label x setting)

• Variable*
• Left
• Center
• Right

Label width justify Justifies the width of the PiP label 
(changing this option will override the 
label x and label width settings)

• Fixed*
• PiP width
• Text length

Label text justify Justifies the horizontal position of the 
text on the PiP label (changing this 
option will override the text x setting)

• Variable*
• Left
• Center
• Right

Label color Sets the color of the PiP label Select a color from the palette in 
the Select a Color dialog box 
(*grey)

Label text color Sets the color of the text on the PiP 
label

Select a color from the palette in 
the Select a Color dialog box 
(*yellow)

Style Sets the transparency style of the PiP 
label

• System*
• Transparent

PiP

PiP x Sets the horizontal position of the PiP 
within the layout (You can also use 
your computer mouse to move the PiP 
around within the layout)

Variable

PiP y Sets the vertical position on the PiP 
within the layout (You can also use 
your computer mouse to move the PiP 
around within the layout)

Variable

PiP width Sets the width of the PiP (You can also 
use your computer mouse to increase or 
decrease the width of a PiP)

Variable

PiP height Sets the height of the PiP (You can also 
use your computer mouse to increase or 
decrease the height of a PiP)

Variable

Table 3-2. Modifiable PiP Properties (Continued)

Property Description Options
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Aspect ratio Sets the aspect ratio—image width to 
image height—of the PiP (changing this 
option overrides the PiP width and PiP 
height settings)

• Custom*
• 4:3
• 16:9

Fix aspect ratio Fixes the aspect ratio of a PiP so that 
changes to PiP width settings are 
proportionate to PiP height settings, and 
vice versa (enabling this option will 
affect PiP width and PiP height 
settings)

• Enable*
• Disable

Border

Left Sets the size border along the left side 
of a PiP (Set this option to 0 if you do 
not want a border to appear)

Variable, depending on PiP 
dimensions

Right Sets the size border along the right side 
of a PiP (Set this option to 0 if you do 
not want a border to appear)

Variable, depending on PiP 
dimensions

Top Sets the size border along the top of a 
PiP (Set this option to 0 if you do not 
want a border to appear)

Variable, depending on PiP 
dimensions

Bottom Sets the size border along the bottom of 
a PiP (Set this option to 0 if you do not 
want a border to appear)

Variable, depending on PiP 
dimensions

Border color Sets the color of the border surrounding 
the PiP

Select a color from palette in the 
Select a Color dialog box 
(*grey)

Crop

Crop x Crops the PiP input horizontally from 
left to right

Variable, depending on size and 
location of PiP (*8)

Crop y Crops the PiP input vertically from top 
to bottom

Variable, depending on size and 
location of PiP (*0)

Table 3-2. Modifiable PiP Properties (Continued)

Property Description Options
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Note
Only the image on the output display device is affected by cropping; the 
PC image remains unchanged. For cropping to take affect, first clear the 
Default Crop box in the System Properties dialog box (see “Allowing 
Crop Changes From PiP Properties Pane” on page 78 for more 
information). The cropping origin is the top left corner. Verify the 
resolution of your input format before cropping in order to avoid entering 
crop values that are too large (that go beyond the PiP actual width and 
height); otherwise, picture may become corrupted.

General Guidelines For Resizing and Editing PiPs
You can use NEO SuiteView Layout Manager to resize, move, and edit 
PiPs within a selected layout. The following section lists some general 
guidelines for resizing and editing PiPs:
• To select and highlight a PiP, click inside it.
• To resize a selected PiP, click-and-drag the handle on the corner or 

side of the PiP.
You can also press and hold CTRL while clicking-and-dragging the 
PiP on a point without a handle.

• To move a selected PiP, click-and-drag from the center of the PiP.
• To retain the PiP aspect ratio, ensure that the PiP property Fix 

Aspect Ratio is checked (PiP properties pane) before you start 
resizing the PiP.

• To undo an edit, open the Edit menu and click Undo, or press 
Ctrl-Z on the keyboard. 
To redo an edit, click Redo from the Edit menu, or press Ctrl-Y.

Crop width Crops the PiP width for display on the 
output display device (The image 
remains uncropped on PC monitor)

Variable, depending on size and 
location of PiP (*704)

Crop height Crops the PiP height for display on the 
output display device (The image 
remains uncropped on PC monitor)

Variable, depending on size and 
location of PiP (*480)

Table 3-2. Modifiable PiP Properties (Continued)

Property Description Options
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• To define a group of PiPs to later move as one object, first enable 
Toggle PiP Grouping from the PiP menu, or click the 
corresponding button on the toolbar. Then, click each of the PiPs 
you want to group together (selected PiPs will change background 
color). Use the mouse to click-and-drag grouped PiPs to a new 
position.
To remove a PiP from a group, click it again. The ungrouped PiP 
background will change back to its original color.
To disable the grouping function, select Toggle PiP Grouping from 
the PiP menu a second time, or click the corresponding button on 
the toolbar.

Modifying Display Layout PiP Properties
To modify the PiP properties of a preset display layout to create a 
custom layout, follow these steps:
1. Select a preset layout to use as a layout display from the NEO 

SuiteView Layout Manager’s Device and Preset Pane by selecting 
a preset layout from the list.

The display layout you selected opens in NEO SuiteView Layout 
Manager.
NEO SuiteView Layout Manager User Guide 67



 Chapter 3: Layouts and PiPs
2. To modify PiP properties using the PiP Properties pane, select 
PiP > Toggle PiP Properties from the NEO SuiteView Layout 
Manager main menu.

3. Select the PiP that you want to modify. 
The properties for the selected PiP appear in the PiP Properties 
pane

4. To modify a PiP property, double-click in the column next to the 
property name that you want to modify, and then make the 
appropriate setting.

Figure 3-3. Modifying PiP Width Using the PiP Properties 
Pane

Copying PiP Properties To Other PiPs
Using the Copy PiP Properties dialog box, you can copy the properties 
of a PiP to selected PiPs or to all the PiP in the layout. Using this 
feature, you can speed up the process of modifying all of the PiPs 
within a layout. For example, to change the border color of all the PiPs 
in the layout, you only need to make this change in the PiP Properties 
pane for one PiP. Then, you can use the Copy PiP Properties dialog 
box to copy the PiP border color change to all the PiPs in the layout 
simultaneously. 
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The Copy PiP Properties dialog box, groups PiP properties into five 
categories: size, label, border, and crop. When copying PiP properties 
from a PiP, all the properties that belong to the selected PiP property 
category are copied over the other PiPs. Table 3-3 lists the PiP property 
categories and the properties that are copied. 

To copy PiP properties and apply them to other PiPs in your layout, 
follow these steps:
1. In the PiP display window, select the PiP from which you want to 

copy properties.

Table 3-3. Copying PiP Properties

Copy PiP Properties Dialog Box Property Categories
Size Label Border Crop

pip x visible left crop x

pip y label x right crop y 

pip width label y top crop width

pip height label width bottom crop height

aspect ratio label height

fixed aspect ratio text x

pip skin text y 

label justify 

label width justify

label text justify

label color

label text color

system
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2. To open the Copy PiP Properties dialog box, do one of the 
following: 
Select PiP > Copy PiP Properties from the main menu. 
OR
Select the Copy PiP properties icon  from the NEO SuiteView 
Layout Manager toolbar. 
OR
Right-click on the PiP from which you want to copy properties
The Copy PiP Properties dialog box opens.

3. From the Properties list, choose the properties you want to copy.

Note
When you choose to copy the Label properties, the label text is not 
copied from one PiP to other PiPs.

4. To copy the selected properties to specific PiPs only, choose 
Selected PiPs, and then from the PiPs list, select the target PiPs to 
which you the properties copied. To select multiple PiPs, hold down 
the Ctrl button when you are selecting target PiPs.
To copy the selected properties to all the PiPs in the layout, choose 
All other PiPs.

5. Click Apply to apply the copied properties to the selected PiPs, and 
then click OK to close the dialog box.
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Saving Your Customized Display Layout
When you have completed making modifications to your customized 
layout, you can rename the layout (if you have not done so already) and 
save it to the Server Disk (a local PC or network drive). Although 
custom display layouts can be saved directly to the NEO SuiteView 
system, it is recommended that you save them to the Server Disk.
To save your customized layout, follow these steps:
1. From the Layout Manager main menu, select File > Save To.

The Save To dialog box appears. 

2. Enter a name for your custom display layout, choose a device or 
folder on the Server Disk, and then click Save.
You can choose to save the layout as a preset on a device. To save 
the custom layout directly to a device (A NEO SuiteView system), 
you must choose which existing preset to replace. Only a maximum 
of 10 preset layouts can exist on a device. When you click Save, the 
new layout replaces the selected layout on the device layout list.

Note
You cannot modify the layout that is currently being display on your 
output display device. 
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Creating New Display Layouts
You can create new display layouts by creating layout files that can be 
stored on the Server Disk (a local PC drive or a network drive). New 
display layouts are created ‘offline’, meaning that the layout is not 
currently being used by the NEO SuiteView system. The new layout file 
is saved directly to the Server Disk and not to the device layout list. 
When you create a new layout file, each PiP in the layout is 
automatically assigned default PiP property settings. These settings are 
similar to the PiP properties that define the preset display layouts. 
To create a new display layout, follow these steps:
1. From the NEO SuiteView Layout Manager main menu, select File 

> Create File on Server Disk.
The Create File dialog box opens.

2. From the PiPs (max) list, select the maximum number of PiPs you 
want available for your layout. 
Your layout does not have display the maximum number of PiPs. 
You can choose to hide or add PiPs to your layout at any time. For 
example, if you select 44 from the PiPs (max) list, you can choose 
to display 32 PiPs. However, if select 16 from the list, you cannot 
display more than 16 PiPs in your layout. 
For information about adding and hiding PiPs see “Adding and 
Removing PiPs From a Layout” on page 73.

3. From the Resolution list, select a resolution for your display 
layouts. 
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4. To save your new layout to the Server Disk (a local or network 
drive), click OK. 
Your new display layout file appears in the Device and Preset pane 
within the Server Disk folder. 

Setting Up Your New Display Layout
There are a number of ways that you can set up your new display layout 
so that it meets your customized requirements. You can modify PiP 
properties, copy PiP properties to and from PiP, and add and/or remove 
PiPs from the layout. To set up your new display layout, see the 
following sections:
• For information about modifying PiP properties, see “Modifying 

Display Layout PiP Properties” on page 67.
• For information about copying PiP properties, see “Copying PiP 

Properties To Other PiPs” on page 68.
• For information about saving your display layout modifications, see 

“Saving Your Customized Display Layout” on page 71.

Adding and Removing PiPs From a Layout
Using the Add/Remove PiP dialog box, you choose to add or remove 
PiPs from a layout display. The follow information should be 
considered when adding or removing PiPs from a layout: 
• PiPs that are added are not automatically aligned with the other 

PiPs in the layout. You must modify the layout’s PiP properties to 
properly realign all the PiPs in the layout.

• PiPs that are added have default PiP property settings. 
• PiPs that are removed are replaced with a blank space in the layout. 

You must modify the layout’s PiP properties to properly realign all 
the PiPs in the layout.

• PiPs that are removed lose any customized PiP property settings.
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To add or remove PiPs, follow these steps:
1. To open the Add/Remove PiPs dialog box, do one of the following 

Select PiP > Add/Remove PiPs from the main menu. 
OR
Select the Add/Remove PiPs icon  from the NEO SuiteView 
Layout Manager toolbar. 
The Add/Remove PiPs dialog box opens displaying the maximum 
PiPs in the layout and indicates which PiPs are currently selected 
for display.

Figure 3-4. Adding and Removing PiPs

2. Select which PiPs you want to add or remove.
3. Click OK to apply your selections. 

PiPs with check 
marks are selected 
for display

PiPs without 
check marks are 
not selected for 
display, but are 
available for 
display
74 NEO SuiteView Layout Manager User Guide



 Chapter 3: Layouts and PiPs
Managing Display Layouts
There are a number of features that you can apply to PiPs and layouts 
that help you manage your layouts. For example, you can group PiPs so 
that they can be moved within the layout space as a group. 
This section includes information on the following topics: 
• “Using the PiP Preview” on page 75
• “Quick-Formatting a Display Layout” on page 76
• “Grouping PiPs” on page 77
• “Using the Layout Grid” on page 77
• “Using the Layout Wall View” on page 78

Using the PiP Preview 
You can use the PiP Preview feature to view an enlarged version of a 
selected PiP to get a closer look of the input’s signal integrity. By 
default, a previewed PiP is displayed in the center of the layout. When a 
PiP is selected for preview, its input is displayed in the enlarged version 
of the PiP. The PiP’s original place in the layout displays gray video and 
the PiP label displays PiP “IN PREVIEW” for the duration of time that 
the PiP is previewed. The PiP preview does not display any activated 
alarms or audio meters that are associated with the PiP that is being 
previewed. 
When you enable the PiP preview feature, only the video of any PiPs 
that are overlapped by the previewed PiP is updated (refreshed). This 
means that any audio meters and alarms associated with the 
overlapped PiPs are not updated (refreshed) until the preview is disabled. 
Any UMD and tally information that is updated on a PiP while it is 
overlapped by the previewed PiP, will be visible through the display of 
the previewed PiP.
To enable the PiP Preview feature for a selected PiP, follow these steps:
1. To enable the PiP Preview, from the NEO SuiteView Layout 

Manager, select PiP > Show PiP Preview.
2. Select the PiP in the layout that you want to preview. 
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3. Right-click on the selected PiP and choose PiP Preview from the 
context menu.

4. To disable the PiP preview and return to regular viewing, from the 
NEO SuiteView Layout Manager, select PiP > Show PiP Preview. 

Quick-Formatting a Display Layout
You can use the NEO SuiteView Layout Manager quick-formatting 
commands to reformat an existing display layout. You can choose to 
reformat your layout to display a 2×2, 3×3, 4×4, or 5×5 PiP 
arrangement.

Note
The PiPs in your re-formatted layout will be set to default PiP property 
values. Any customized PiP property settings are lost when you use 
the quick-formatting feature. 

To use a quick-format command, either select PiP from the main menu, 
or right-click on the selected layout in the device and preset pane, and 
then choose from one of the following quick-format commands:
• Create 2 by 2 Layout Reformats the current layout arrangement 

to a 2 PiP by 2 PiP layout
• Create 3 by 3 Layout Reformats the current layout arrangement 

to a 3 PiP by 3 PiP layout
• Create 4 by 4 Layout Reformats the current layout arrangement 

to a 4 PiP by 4 PiP layout
• Create 5 by 5 Layout Reformats the current layout arrangement 

to a 5 PiP by 5 PiP layout
Your display layout will be re-formatted with the selected layout 
arrangement. 
76 NEO SuiteView Layout Manager User Guide



 Chapter 3: Layouts and PiPs
Grouping PiPs
Multiple PiPs can be selected and moved simultaneously by using the 
PiP grouping function. To group PiPs, follow these steps:
1. Select PiP > Toggle PiP Grouping from the main menu. 

OR
Select the Toggle PiP Grouping icon  from the NEO 
SuiteView Layout Manager toolbar.

2. In the PiP display window, click the PiPs you want to group.
PiPs change color to indicate that have been grouped. If you want to 
remove a single PiP from the group, click it. Ungrouped PiPs return 
to the previous color. 

3. To move the grouped PiPs to a new location, click and hold the 
mouse button while you drag the PiPs to the new location.
You can also use the keyboard arrows to move the grouped PiPs to 
the new location.

4. Click Toggle PiP Grouping from the toolbar to disable the 
grouping function.
Grouped PiPs will return to their previous color.

Using the Layout Grid
You can enable the grid function to help you reposition and align PiPs 
within the layout. When the grid is enabled, a series of horizontal and 
vertical dotted lines, which makeup the grid pattern, appear in the 
layout. The grid spacing can be modified as well by entering new values 
in the X and Y boxes on the toolbar. The grid is only a visual guide; 
PiPs cannot snap to it.
To enable the grid feature, click Toggle Grids  icon from the toolbar. 
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Using the Layout Wall View
You can enable Wall View to see the layouts that are currently being 
used by multiple, networked NEO SuiteView systems. The default 
Manager View displays the layout of one connected NEO SuiteView 
system. The Wall View displays multiple selected systems in a way that 
resembles a control room monitor wall.Wall view is useful when 
planning an entire video wall layout. Figure 3-5 illustrates a portion of 
the window in Wall view.

Figure 3-5. Wall View

To enable Wall View, from the NEO SuiteView Layout Manager main 
menu, select View > Toggle Wall View.You can also enable Wall View 
by clicking the Toggle Wall View icon from the NEO SuiteView Layout 
Manager toolbar.

Allowing Crop Changes From PiP Properties Pane
By default, NEO SuiteView Layout Manager prevents crop changes 
from being made in the PiP Properties pane (see using these attributes: 
Crop X, Crop Y, Crop Width, Crop Height. To disable this 
preventative feature and allow crop changes from the PiP Properties 
pane, follow these steps:
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1. Right-click a system in the Device and Preset pane and then select 
System Properties to open the Properties dialog box.

2. Select a PiP from the list, and the clear the associated Default Crop 
box.

3. Click OK to set the change, and then close the dialog box.
4. Return to the main window and then set the desired Crop X, Crop 

Y, Crop Width, Crop Height values within the PiP properties 
pane. The cropping origin is the top left corner of the PiP.

You will only see the effect of your PiP cropping changes on the output 
display device. PiPs on your PC monitor remain unchanged. Table 3-4 
lists the default crop settings for the each video format:

Table 3-4. Default Crop values

Video Format Crop X Crop Y Crop 
Width

Crop 
Height

720 p 21 0 1247 719

1080i 8 0 1912 1080

525 (NTSC) 8 0 704 480

625 (PAL) 8 0 704 480
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